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EXCEL ADVANCED 

 Statistical functions (Review) 

It is possible to manually enter the formula or function without the assistance of the tools.  It should be 
remembered, however, that Excel needs very specific instructions, the syntax of the formulas must be 
respected when it comes to typing them or an error is generated. 

EXERCISE Statistical function 

Open the file « Formulas step 1 », sheet « Review 1 » 

1. Activate cell B8 to get the average of "Session 1"  

2. Type =AVERAGE, type parenthesis " ( + the cells containing the results of "Session 1" ) 

=AVERAGE(B3:B7), the result is "41.25"   

3. If you want to get the "Maximum" grade, type "MAX" or for the "Minimum" grade, you will 

type "MIN" 

4. Click OK 

 

FUNCTIONS EXPLANATION 

SUM 

 

MAX 
 

MIN 
 

AVERAGE 

 

COUNT 
 

COUNTA 
 

Note : 

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  
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 RELATIVE OR ABSOLUTE ADDRESSES 

 

 Whose formula adjusts during a copy. 

Example of RELATIVE ADDRESSES:  

Amount Description Price Total 

20 Computer 2000 =A2*C2 

25 DVD 275 =A3*C3 

15 iPad 950 =A4*C4 

 

 Fixed address, it does not change during a copy. 

Example of ABSOLUTES ADDRESSES:  

Description Price Gst Qst 

  5% 9,975% 

Computer 2000 B3'$C$2 =B3*$D$2 

DVD 275 B4-$C$2 =B4*$D$2 

iPad 950 B5-$C$2 =B5*$D$2 

 

 Relative column and absolute line: B$2. Row 2 stays fixed, while the column adjusts when 
copying. In our case below, by copying the formula to the right, Excel calculates the timelines 
of each row from the deadlines located only in row 2 for each column. 

 Absolute column and relative row: $A3. Column A remains fixed while the row adjusts when 
copying. In our case below, by copying the formula down, Excel calculates the timelines of 
each row from the dates located only in column A. 

Example of RELATIVES AND ABSOLUTES ADDRESSES 

Billing Date DEADLINE 1 DEADLINE 2 DEADLINE 3 DEADLINE 4 

  30 60 90 360 

2023-09-15 =$A3+B$2 =$A3+C$2 =$A3+D$2 =$A3+E$2 

2023-08-21 =$A4+B$2 =$A4+C$2 =$A4+D$2 =$A4+E$2 

2023-09-18 =$A5+B$2 =$A5+C$2 =$A5+D$2 =$A5+E$2 

 

 The cell chosen to perform the formula remains the same. Excel returns to the same column 
and line when copying.  
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 Transpose: Going from rows to columns 
Open the file « Formulas step 1», sheet « Transpose » 

1. Select cells A2 to M12 

2. Click the Copy button on  Home tab Clipboard Group  

 

3. Activate cell A15 to change the row and column headers 

4. From  Home tab  Clipboard Group  Paste  Paste Special  choose  Transpose 
from the "Paste Special" dialog box 

5. Or right mouse button  choose 

  

6. Click OK, here's the result below 
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 Date function 

 

 Activate the destination cell to insert the date of the day. 

 Press the "CTRL" button, then the "semicolon" ";" button. Today's date appears.  

"CTRL +  ; " 

 

 We want to insert a date that will be updated in future use of the workbook.  How do I do 
that?  Activate the destination cell, TYPE: The sign = and type TODAY, add an opening and 
closing parenthesis ( ). Confirm with Enter 

 

 

1. Select the cell to be formatted. 

2. Using the pop-up menu obtained by clicking with the right mouse button, click  Format 
Cells  Font tab of the Home tab 

3. Tab  Number, in Category, choose option  Custom. 

4. In the typical area, enter the following code: d mmmm yyyy 

 

This function is used to retrieve from a date, either year or month or day. 

Open the "Formulas1 Workshop" file, "Employees" sheet  

1. Activate cell "B2" In "Function Library" of the "Formulas" tab,  

2. Click on "DateTime" Choose either "YEAR OR MONTH"  

3. In "Function arguments", click on "A2" » 
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 Formulas: INT  

This "INT" formula represents rounding down one number to the nearest integer. This function is 

equivalent to "ROUNDED. INF" (Integer value)  

1. Type the age in cell A1, someone who was born in 2000 and that his birthday is tomorrow 

2. In cell A2, type the following formula: TODAY() WHICH REPRESENTS TODAYS DATE 
(DYNAMIC DATE) 

3. TODAY() MINUS HIS DATE OF BIRTH, CELL A1, 

4. Parenthesis for " (TODAY() AND A1) " then divide by 365.25 

5. This person will be 23 years old tomorrow only 

6. Click in the Formulas tab 

7. Choose: INT from MATH &TRIG, or type in front of your formula =INT( then close your 
parenthesis at the end. Do not touch inside of the formula. 

8. Watch your result: THE VALUE IS 22 

9. Tomorrow, your result SHOULD BE 23  

10. To save a step: in cell A2, type the following formula: 

 

Here is an example with the month and day "Today" but born in "2000"  

If necessary, open the " Formulas Step 1", "TODAY_NOW" sheet. 

1. In cell C2, type the following formula: TODAY() which represents today's date (DYNAMIC 

DATE)  

2. In cell C3, type the following formula: NOW() which represents the date and time of the day.  

3. In cell "C5",  

 Enter the year 2000. 

 The current month  

 The day of "Tomorrow" 

 In cell "C6," enter the following formula:  

 TODAY () MINUS HIS DATE OF BIRTH 

  

 Cell "C7", in parentheses "(C2 or TODAY() – C5)", then divide by 365.25 

     
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 Cell "C8", you must obtain the integer value with the function "INT" 

 Or you type = INT and click in cell C7, close parenthesis 

 Or Add "INT" immediately after "=", we have opened a parenthesis, so we must close it at 
the end of the formula. 

 

 In cell "C5", replace the day for today's According to our calculations, age should have an 
additional value 
We add +1 like this: 

 

Now let's see the other formulas for age calculation 
Look at the dates that are in column "E to H” 

Anniversary 
date 

AGE FORMULA DESCRIPTION 

2000-10-02 23 =INT(YEARFRAC(E2;TODAY())) AGE FRACTION - GOOD   

2000-10-02 23 =INT((TODAY()-E3+1)/365,25) 

AGE WITH "INT" - GOOD   

 

2000-10-02 22 
=INT((TODAY()-E4)/365,25) 
For Excel, the age will be change  
after the end of the day 

FORMULA USED - NOT GOOD  

if we don't take time into account  

2000-10-02 23 =DATEDIF(E5;TODAY();"y") 
AGE WITH "DATEDIF" 

Very GOOD but not in the formulas "DATE"  

 NETWORKDAYS 
This formula calculates the number of days between two dates, considering Saturday, Sunday, and 

holidays. 

Open Formulas Step 1, NETWORKDAYS sheet 
 Cell « C2 » 

 In "Function Library", Book "Date & Tim", choose "NETWORKDAYS" 

 Select A2 for "Start_date" 

 Then B2 for "End_date" 

 Select A8 to A10 (All your holidays) 
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 Touch F4 to lock cells. 

 The result is: 16 

 Representing number of days without Saturday and Sunday and holidays 

 

 SUMIF 

This function allows you to make the sum of a range according to a criteria. 

This criteria can apply on the range you want to add or on another range with the sole condition that the 
two ranges are the same size. Its syntax is SUMIF ([range], [criteria], [sum_range]) where  

Range represents the range on which the criteria will be applied, it can be the same as "sum_range" 

 Type these data in a sheet 

  

 Criteria must be in the form of a number, text, or expression of comparison. This criteria 
must be placed in quotation marks and cannot depend on a cell. Example: "<>10" 
(Different from 10) 

 Sum_range is the range on which the sum will be applied. 

The function will cover the range and for each cell X, it will check whether the cell Y, from the same 

position in the range sum_range, actually meets the condition indicated in criteria, if so, it adds the value 

of the X cell to the result. Example:   

Sum of the set  
Answer: 176 

 

FORMULA: =SUMIF(A1:A6;"Surgery";B1:B6) 

SUMIF  
Condition: Surgery 

Answer: 89 
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 COUNTIF 

This function counts the number of cells corresponding to a criteria in a range. It works much like the 

previous function. Its syntax is COUNTIF([range] , [criteria]) - range represents the range that will be 

counted. 

 Criteria must be in the form of a number, a text, or an expression of comparison. These 
criteria must be put in quotation marks and cannot depend on a cell. The function runs 
through each cell in the range, if the content of that cell corresponds to the condition 
indicated in the criteria, it adds 1 to the result.  

Example: COUNTIF 
 In the previous table, how many lines contain the word "surgery" 

 In cell B9, type = COUNTIF( 

 In Range, choose A1 to A6 

 Criteria: Type: "Surgery" 

 

  =COUNTIF(A1:A6;"Surgery") = 3 

 LARGE - SMALL 

This function returns the k-to highest value (or smaller value) of a data series. You can use this feature to 
select a value based on its rank. So, you can use the LARGE function VALEUR to return the highest result, 
the second or the third. SMALL to return the smallest result, the second or the third. 

Example: "LARGE" 
In the previous table, what is the largest value in column B 

=LARGE(B:B;1)= 55 ("K1" represent "the greatest value") 

 
In the previous table, what is the smallest value in column B   

=SMALL(B:B;1)= 10 

If you like to get the second highest value,  
CHANGE "K"  

TO READ "2" INSTEAD OF "1" 
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 AVERAGEIF 
The function AVERAGEIF () refers to the average (arithmetic) of all cells that meet several criteria.   

=AVERAGEIF ([range];[criteria];[average range]) 

Where:  

 

 

 

 

 

 

 "au*" or "au" or "*au" → all words beginning with 'au', all words ending with 'au', all words 
containing in.  

 A star can replace any character and does not specify the number of characters replaced. 
Au* will find aux and others. 

 You can also use a "?", this one will replace only 1 character,  

 Example: au? will find aux, but not others.  
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 Function IF 

Using "IF" to check a condition, then (what should be done?) if not (What to do?)  

If A2 is greater than 40000, then multiply A2 by 5%, if not (in all other cases, 0 or ""  

IF (A2>40000) A2*5% 0 or "" 

[logical_test] [value_if_true] [value_if_false] 

  

Allows the use of comparison operators: >   <   =   <=   >=   <>   Text must be in quotation marks "   " 

Example: IF 

Open “Formulas Step 1”, “Statistics” sheet 

If the city is not "Montreal', Yes for "expenses account", IF FALSE "No" (to read 
in the cell (Column E) 

 Click on cell E2. 

 Type =IF( 

 Click in B2. Type <> (these 2 signs together mean not) 

 Text Montreal under quote 
[logical_test] B2<>"Montreal" 

 Coma or semicolon 

 [value_if_true] type "YES" 

 [value_if_false] type "NO" 

 Close parenthesis 
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 Function AND 

Returns TRUE if all arguments are TRUE; FALSE if at least one of the arguments is FALSE. 

 This function is usually used nested in another logical function 

 Condition: Exam 1 – 2 and 3, note must be greater or equal to 60: 

 Value "TRUE" is "Success", value FALSE is "Failure" 

  

 Function OR 

 Returns TRUE if one of the conditions is TRUE and the FALSE if all the conditions are FALSE 

 The OR function is usually used nested in another logical function. 

Examples of formula: IF &"OR"  

 Condition: Sale >=30000 

 Or Experience >=5 (years) 

 Value "TRUE": Commission 10% 

 Value FALSE: Commission 5% 
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 Function ISBLANK 

Copying a formula that refers to an empty cell causes a null result to appear or an error message to 

appear. This function is often combined with IF 

The following example results with EMPTY CELL "Column G". To avoid these problems, as in column 

G, the following formula will be used:  

 

You can use this formula also: 

 

 

 TEXT FUNCTION

 

To convert text to upper case, here's how to do it:  

1. Open a new file 

2. Type your last name into cell A1 

3. Click in the Formulas tab 

4. Choose: TEXT 

5. Choose: UPPER 

6. In Function Arguments: click in cell A1 
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 LOWER: CONVERT YOUR TEXT TO LOWER CASE 

 TRIM: Delete spaces before and after but not between 

 PROPER: Get the first letter of each word in capital letter:  
example: anna maria for Anna Maria or 
jean-pierre for Jean-Pierre 

 SUBSTITUTE: Replaces existing text with new text, this function will also delete space 

in a cell. Attention: you must respect the case. 
Example  

 

 

To replace or remove the original cells, you need to copy and then 
paste the value.  

 

Union of 2 or 3 columns in a single cell  
Here's how to get your first and last name in one cell:  

 

1. Type your first name in cell A1 and your last name in cell B1 

2. In cell C1, click in the Formulas 
tab 

3. Choose: TEXT 

4. Choose: CONCAT 

5. In Function Arguments CONCAT:  

6. Text 1: Click in cell A1 

7. Text 2: Make your space 
(keyboard) 

8. Text 3: Click in cell B2 

9. Watch your result 
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1. Type your first name in cell A1 and your last name in cell B1 

2. In A2, type = 

3. Click in cell A1 

4. Type & (located above number 7) 

5. To insert a space between your first and last name, type " " (quotation marks, 

space, quotation marks) 

6. Retype & 

7. Click in cell B1 then enter 

8. Here is the formula and the result: 

 

 

Steps to get one or a few characters in a cell  

1. Type your name in cell A1 

2. Click in the Formulas tab 

3. Choose: TEXT 

4. Choose: LEFT or RIGHT 

 

5. In Function Arguments: Text: Click in cell A1 Num_chars:  Choose the number of 
characters needed 

6. Observe your result which is RIC  
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 CONVERTING DATA 

This function allows us to separate the text of a cell into several columns. Or for example, to convert a date 
that is in TEXT format into a DATE format 

 

 Convert 

This function allows us to separate the text of a cell into several columns. Or for example, to convert a date 
that is in TEXT format into a DATE format 

 

 

 Select A1 to A5 

 From the Data tab 

 Click in Convert (Text to Columns) 
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 Choose Delimited in Step 1 of 3 

 

 Next > (Step 2 of 3) 

 Choose the comma. 

 View the result in the Data preview. 

 Click Finish 

 

 Result 
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Our goal will be to separate the first two letters and numbers; 
however, we must keep the zeros. 

 

 

 Select from A8 to A10 

 From DATA, Text to columns 

 In "Convert Text…", choose "Fixed Width" Go to "Next."  

 Click between letters and numbers 

   

 Next > 

 First column remains General. 

 Second column, change General for Text 
Finish 
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1. Type a date like this: (DD-MM-YYYY), 25-12-2023 

2. Notice that EXCEL does not recognize this date 

3. Click Convert 

4. Immediately move to Step 3 of 3 

5. Choose: DATE 

6. Choose from the drop-down list the date format we typed: DMY 

7. Click Finish 

 

Note 

 ___________________________________________________________________________________  

 ___________________________________________________________________________________  

 ___________________________________________________________________________________  

 ___________________________________________________________________________________  

 ___________________________________________________________________________________  

 ___________________________________________________________________________________  

 ___________________________________________________________________________________   
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 NAME MANAGER 

A name is an evocative alias that allows you to immediately know the function of a cell reference, a 

constant, a formula or a table that might otherwise be difficult to guess at first.  

After selecting the range to be named, use  

Formulas tab  Define name 

    

OR 

After selecting the range, click on the left portion of the formula bar and enter the name:  

 

OR 

After selecting Create from Selection from the Formulas tab  

 

 To name a cell or cell range:  

 Select a cell or range of cells you want to name.   

 Click in the Name area, to the left of the formula bar.   

 Enter a name that will serve as a reference for the cell. Validate by pressing the Enter button.  
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 The first character of the name must be a letter, an underline (_) or a dash (-). Afterwards 
you can use letters, numbers, underline, or the dot. Your name should not exceed 255 
characters.  

 Upper and lower case are not considered, in other words, an upper case is equivalent to a 
lower-case letter. So, CLINIC is the same as clinic, Excel won't tell the difference between 
the two.  

 Make sure that the name used does not correspond to a cell. For example, F7 is a cell, so it 
is forbidden to use its name.  

 Finally, the name used may refer to an area (thus a cell range), but it may also have as a 
scope a sheet or a workbook.  

 

 in the Formulas tab, in the Defined Names group,  

 

 Show names  

 

Once you've set the name of a range, you can easily reach 
the range from the Name Box of the formula bar. 

 

 

Range names are useful for creating a formula. Instead of entering the Address of a range, we can use its 
name. Example: VLOOKUP or a formula 
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 From the Formulas tab  Name Manager  

 Select the name to be deleted and choose "Delete" from the "Name Manager" dialog 
box 

 

 Function VLOOKUP 
Search functions allow you to search for a value in a table, for example: a name, a product number, invoice 
number, phone, address, etc. 

Definition: This feature searches for a value in the first column of a table, which returns the value contained 
on the same row and in another column. 

Dialog box "FUNCTION ARGUMENT"  

VLOOKUP 

Lookup_value Identifies the cell that contains the value that the function looks for in the first 
column of the table 

Table_array Identifies the range (either by an already defined name or by the data 
selection) in which the value search is performed 

Col_index_num 
Shows which column the value is in. The columns are numbered from the left. 

Range_lookup Enter TRUE if you want the function to return the value closest to the 
one requested "This argument is optional". Enter FALSE if you only want 
exact values. If no value is linked to it, this feature will return #N/A. If you 
don't specify it, EXCEL assumes that the value is TRUE 

 

From the "File" tab, "Options" and "Formulas", check:  R1C1 reference style in "Working with 
formulas." 
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Look for the name of the company for which the customer number is "VS-1255", How to do it? 

Open the file "Travel_VLookUp"  

1. To make it easier, you'll give your data range a name, select the range A1 to J308 from the 

"Customer" sheet. 

 

2. From the Formulas tab  Define Name type "Customer" in  New Name 

3. Also give a name from sheet "Travel" Example "City" 

  

4. Return to sheet "Invoice", click in cell B5 to search for the customer's name "VS-1227". 

5. Click Lookup & Reference  Formula Tab, choose  

 VLOOKUP 

 

6. You are now in the "Function Arguments" dialog box. 

7. Lookup_value is the "VS-1227" customer number, so you need to click cell F5, which 

represents the desired value 

8. Table_array: Enter the name of the table "Customer"  

9. Col_index_num is the column number of the argument you're looking for, i.e. that the 

customer's name is located in column Number 2, insert the number "3"  

10. Range_lookup: type FALSE or value 0 
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11. Click OK 

12. Answer: =VLOOKUP(F5;Customer;3;False) 

13. To save time  Lock F5  $F$5 

14. Repeat the same steps to search for the address, and contacts. 

15. See the table on the next page for column number identification. 

16. In cells F11 and F12, VLOOKUP to get the amount of the trip 

If the F12 cell is empty, a formula must be inserted to eliminate an N/A value when the 

sheet will be protected in writing. 

 

 Function HLOOKUP 

Definition of HLOOKUP: Finds a value in the top row of a table, and then returns a value in the same 
column from a specific row. 

Our goal is to "GET A DISCOUNT BASED ON THE COST OF THE TRIP"  

1. To save time, open the workbook "Invoice - Answer " sheet. 

2. Please delete the answer in cell "F16" 

3. Objective: redo the formula HLOOKUP 

4. In cell "F16" activate "HLOOKUP 

5. "Lookup_value" is "F15"  

6. "Table_array" select the "DISCOUNTS - FEES" sheet, cell from "A2 to F3". 

7. "Row_index_num", enter the number "2". 

False or 0 
0 
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8. "Range_lookup", enter the number "1" 

 

9. Answer is "0,2" – 20% discount, then multiply by "F15"

  

 

 CIRCULAR REFERENCES 

A formula cannot refer to itself or to another cell whose formula refers to itself. So, if in cell A1 you write 

=A1 or =A2+A3 while the formula in A3 is =A1, Excel warns you of the presence of a circular reference.   

Correct the formula AUDITS AND CHECKS 

 

 

Save your workbook to save the final version of your table, then:  

1. Click the formulas tab  Formula Auditing  Show Formulas.   

2. Check the preview before you print: your table should fit on a single page 
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1. Go to a cell containing a formula 

2. Click the Formulas tab  Trace Precedents 

 The cells used by the formula will be visualized.  

3. Go to a cell containing a number 

4. Click the Formulas tab  Trace Dependents 

 The formulas that use the cell will be visualized.  

 

 Click the Formulas tab  Remove Arrows 

 

 Pivot Table 

The Pivot Table (PT or report) is a multidimensional database analysis tool. It is dynamic because any 
change in the source results in the report being updated when the update is triggered. The PT allows you 
to quickly group, combine and compare a lot of information.  

Each column header in the database becomes a pivot table field. Each next row corresponds to a record.  

The presentation of the summary table is defined by the filter and grouping options, the position of the fields 
and the formulas applied. The PT allows predefined calculations (sum, number, count, average, product, 
numbers, max, min, stdev, stdevp, var, varp). You can also create your own formulas by inserting calculated 
fields and elements.  

The effectiveness of a pivot table is based on a properly structured database.  

Each cell in the first row contains the name of the fields (header).  

 The following rows contain the recordings.  

 The database should not contain two identical field names.  

 Avoid empty cells in fields that store numerical data. 

 The database should not contain empty columns. 

 The database should not contain empty rows. 

 The database should store only raw data (no sub-total rows) 
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All the most appropriate commands are in the two context tabs: PivotTable Analyze and Design 

 

 

The pivot table command is very useful when you need to filter multiple fields from the same list (database). 
This command creates a table that calculates values using a synthesis function, such as "Sum", "Average", 
and other... 

At the last step of this assistance, EXCEL creates a table template in which you can drag different fields 
from your list. Excel gives names to fields, here are the names with the definitions: 

 

1. Select a single cell from the database 

2. From the Insert tab Click  Pivot Table  

    

3. Select data to be analyzed as needed 

4. Or use another external data source 
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5. Determine where you want Excel to display your pivot table 
 In a new sheet or an existing sheet 

6. Click  OK 

 

     

 

 This field is used to extract data according to the selected item. This field represents the 
Page Field. 

 Now, if more than a filter, we will use the Slicer 

 

 The "Filters" area is used to hide or display subgroups of data in the pivot table.  

 New cells, including an icon, appear in the spreadsheet, just above the PT.  

 Click on the icon to see the window that lists the elements of the filter field.  

 The unchecked items are not considered in the report.  

 Each time one or more items are checked in the choice list; the pivot table is updated and 
presents only the corresponding filtered data.  

 A filter icon (funnel-shaped image) is displayed in the PT when elements are filtered.  

 A filter icon also appears on the right of the name, in the "Pivot Table Fields" window. You 
can also filter the field by clicking this button.  

 You can also accumulate and sort multiple fields in the filter area of the report.  

 

1 3 

4 2 
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 The values of this field are arranged horizontally.  
Every element of this field is displayed on a row. 

 

 The values are arranged vertically.  
Every element of this field is displayed in a column. 

 

 The data in this field is used to make the calculations. 

 Filters Column field 

 

 Row field Data field 

 

 The "Field List" button hides and displays the "PivotTable Fields" window. The "hidden" 
setting prevents the window from being automatically displayed when a report cell is 
selected.  

 "+/- Buttons" allows you to display or hide the develop/reduce buttons in the report. 

 The "Field Headers" option hides and displays the field headers of the rows and columns. 

 

  



 

 

 

 
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 You can read or change the name of the active field from the input area  

 When you select rows or columns labels, the two buttons containing a "greener" and a "less 
red" button are available. The 'Plus' expands all the elements of the active field and the 
'Minus' collapses all elements of the active field.  

 To hide the details 

 To view more details 
 The "Field Settings" button shows the dialog box of the same name, depending on the 

active cell. 

 

 

   

 "Sum" returns the sum of all the values of the field. 

 "Count" returns the number of records in the field. 

 "Average" returns the average of all the values in this field. 

 "Max" returns the highest value of the field. 

 "Min" returns the smallest value of the field. 

 "Product" multiplies all the values of the field. 

 "Count Numbers" returns the number of digital records in the field. 

 "StdDev" returns the standard deviation of the field. 

 "StdDevp" returns the standard deviation of a population. 

 "Var" returns the variance of the field. 

 "Varp" returns the variance of a population.  
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 "No calculation" uses routine operations. 

 "% of Row Total" calculates the percentage of the row’s total.  

 "% of Column Total" calculates the percentage of the column’s total.  

 "% of Grand Total" calculates the percentage of the overall total.  

 "Index" calculates relatively ((value in cell) x (Grand Total)) / (Grand Total of the line) x 
(Grand Total of the column)).  

 "Running Total In" calculates a cumulative total for the base field.  

 "Difference from" calculates the percentage difference relative to the value of the base 
item in the Base Field.  

 "% of" calculates the percentage of the value of the base item in the Base Field.  

 "% Difference From" calculates the percentage relative to the value of the base item in 
the Base Field.  

   

The "Field Settings" window also contains other information and options:  

 The name of the source field.  

 The custom name that appears in the report and that is changeable.  

 The "Number Format" button to customize the values presented in the PT. This will freeze 
the field format even if the data is changed or moved.  

 You can accumulate multiple summaries of the same field in the area. Then assign a type of 
calculation to each. This allows you to quickly visualize additional information on the field to 
be analyzed.  
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The "Sort" group allows you to sort the selection in ascending or decreasing order. If you 
have any doubts about the result (depending on the cell selected), click the "Sort by value" 
button beforehand. The window contains a description of the sorting that will be done. 

We will get this option with the right click mouse button.  

 

 

The "Group selection" button creates a set from the items you select in the report. 

 When you expand the group, each item value will appear 
separately. When the group is collapsed, the PT displays the 
total of the constituent elements.  

 The "Ungroup" allows you to delete the selected group. 

 The "Group field" button allows you to summarize numerical 
or Date elements in the report. For example, select a date in 
the PT and then click the "Group Field" button: Choose the type 
of grouping (per month).  

  

 The pivot table then returns the elements grouped according to the chosen element:  

 You can select multiple group options at the same time. Click the "Ungroup" button to 
remove groups. 

 Numerical elements can be grouped in the same way. Example for grouping values by ten:  
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The "Clear" button contains two options that delete the entire pivot table 
or delete all filters in the report. 

 

The "Select" button allows you to quickly activate certain cells in the 
report: 

 Labels and values.  

 Labels alone.  

 Values alone.  

 The entire pivot table. Make sure the "Enable Selection" 
option is enabled and that the full PT is selected to un-grey 
the menus. 

The "Move Pivot Table" button changes the location of the report to 
another cell in the workbook or to a new sheet. This method keeps your 
custom cell formatting after moving.  

 

 

 

 It is important to always refresh the data when you're working 

 

 Also, make sure the pivot table includes all the new data  

 

The "Options" button displays the "Pivot Table Options" dialog box. The window is made up of 5 tabs.  
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"Layout & Format" tab 

 Merge and center the cells with labels.  

 Indent row labels when the report is in compact 
mode (between 0 and 127 characters).  

 Sets the display order of the filter fields (Down, 
then over or Over, then down).  

 Assigns value to empty cells. Indicate 0 in the 
numerical fields, to make later calculations more 
reliable. 

 Preserve cells formatting when updating data. 

 

The "Totals and Filters" tab 

 Shows or hides row and column totals 

 Adds or removes filtered items in sub-totals. 

 Allows multiple filters per field (to use all values 
in sub-totals and grand totals, otherwise the 
calculation will not consider hidden/filtered 
items). 

 

The "Display" tab 

 Shows or hides expand/collapse buttons 

 Shows or hides the tooltips that appear when 
you move the mouse over a value cell in the 
report. The tooltip info returns the name of the 
field, the value, as well as the names of row and 
column labels. 

 The "Classic layout" option allows you to 
drag/drop. 

 Shows or hides line items that do not contain 
value. 
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The "Printing" tab  

 Prints expand/collapse buttons. It is best to 
uncheck this option to improve the readability of 
the print.  

 The option "Repeat row labels on each printed 
page". 

 Set print titles: repeats column headers, rows, 
and column labels for all printed pages.  

The "Data" tab 

 The "Save source data with file" option backs up data 

from the external source with the workbook. 

 "Enable show details" to extract and view data detail 

in a new spreadsheet.  

 Refresh data when opening the file. 

 

 

Layout 

 The "Subtotals" button allows you to: not display sub-totals. Show all sub-totals at the 
bottom of the group. Show all sub-totals at the top of the group.  

 The "Grand Totals" button allows you to: Turn off for lines and columns. Turn on for lines 
and columns. Turn on for lines only. Turn on for columns only.  

 The "Report Layout" button defines the type of pivot table. Compact form is the default 
format under Excel2007. In Outline form, each row label has its own column. Tabular form 
displays the data as a table.  

 The "Blank Rows" button inserts or removes a blank line between each group of items. 
The insertion of lines spreads and improves the presentation of the report.  
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Style 

 The checkboxes define the behavior of the style applied to the PT. Options make it easier to 
format and read the report.  

 

 Row Headers displays a formatting on the first row of the report.  

 Column headers display a particular formatting on the first column of the report.  

 Banded Rows allows different colors to be applied between the even and odd rows of the 
report.  

 Banded columns offer different colors to be applied between the even and odd columns of 
the report. 

 

 This option allows you to choose a style of presentation from a wide range of predefined 
formats.  

  Click in the lower right corner of the drop-down menu to see the different styles. You can 
also remove a style from the list or add a custom style. A custom style can be defined as the 
quick style of the default pivot table, for the document. 

 

Calculated fields  

If the predefined formulas are not enough to summarize the value fields, you can create personal functions 
tailored to your project. These formulas are called calculated fields and calculated elements.  

The calculated fields are based on data from other fields. To 
create the formula, select the "Analyse" tab in the ribbon. Click the 
"Fields, Items, & Sets" button in the "Calculations" group. Choose the 
"Calculated Field" option. Name your formula in the "Name" zone. It 
is also in this drop-down menu that you select an existing calculated 
field to change or delete it.  
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Example: To find the total price of wine in "Stock"  per country 

 

1. Open "Pivot Table"  Workbook  "Supermarket" sheet 

2. Create a Pivot Table  

3. Insert "Products" in row label and "TotalSales" to "Values" 

4. Choose "Calculated Field"  Group Calculations 

5. Name: type "Taxes" 

6. Formulas: = TotalSales*14.975% 

7. Click OK 

8. See your result 

 

Note: 

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  



 

P a g e  | 40  E X C E L  A D V A N C E D  

 

A Slicer is a filter, instead of using the "Filter" field, we'll use "Insert Slicer" because we have 

multiple elements. The "SLICER" is very visual and interesting. 

    

 

Let’s take the example of the “Patient” sheet of the “ Pivot Table” Workbook  
You would like to know the number of appointments per site  

 Place "Site" in "Rows" and "Date of Appointment" in "Values"  

 "Insert Segment" choose "Specialty". 

 Choose: Cardiology – Surgery – General – Obstetrics. 

 Expand the box if necessary to see all the specialties 

 

 Now you want to choose some doctors. 

 Return to "Insert Slicer" choose "Doctor’s Name" 

 Observe that the doctors who are dark blue represent those who are selected in the 
specialty. 
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 Now choose a few doctors like this (Blue selection) 

  

 Look again "Specialty" 
“Obstetrics” is grayed out, which means the doctor was not selected. 

 Also note that we have “3 Columns” for doctors, it's up to you to decide the number of 
columns you want to see and the necessary width. 

 

 You have also "Slicer Styles" 

 

 To remove A filter of "Doctor’s name" or from "Specialty" click on  

NOTE 

 ___________________________________________________________  

 ___________________________________________________________  

 ___________________________________________________________  

 ___________________________________________________________  

 ___________________________________________________________  
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A "Timeline " is a “Slicer” with "date " 

 

We will continue the previous exercise with "Timeline" 

In "Timeline ", we have 4 choices:  

 YEARS 

 QUARTERS 

 MONTHS 

 DAYS 

Let’s take again “Patient” sheet of the “Pivot Table” Workbook  
You would like to know the number of appointments per site ,  

 Place "Site" in "Rows" and "Date of Appointment" in "Values"  

 Choose the month of November 2023 and select date to the end of February 2024 

 First, choose "MONTHS" 

 Then click in Nov 2023, with the moose, move to Feb 2024 

 

 Modify "MONTHS" for "DAYS" 

 Select the first 10 days of November 2023 
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 Data validation 

Data validation controls the type of data and values that users enter a cell. For example, you may want to 
restrict data entry to a certain range of dates, limit the choices available by using a list, or make sure that 
only whole numbers have entered. 

This article describes how data validation works in Excel and presents the different techniques available. It 
does not address cell protection, that is, the feature that allows you to "lock" or hide certain cells in a 
spreadsheet to prevent data from being changed or replaced. 

 

Data validation is an Excel feature that sets restrictions on the type and values of data allowed in a cell. 
You can set up data validation to prevent users from entering data that is not valid. If you prefer, you can 
allow users to enter invalid data but notify them when they type it into cells. You also can display messages 
detailing the type of input expected for cells, as well as instructions to help users correct errors. 

If users ignore this message and type invalid data into the cell, such as a two- or five-digit number, you can 
display an error message. 

 

Data validation commands are located under the Data tab in 
the Data Tools group. 

Be careful, you must respect the case  

 

Data validation is particularly useful when sharing a workbook with others in your organization, for which 
you want the data entered to be accurate and consistent. 

You can use data validation to perform, among other things, the following tasks: 

 

1. In a new sheet  in Pivot Table workbook, insert the column Payment Type into A1. 

2. Select cell A2 or the entire A2:A10 range, then go to the Data Validation box 

3. Select  List  in Validation criteria  Allow 

4. Type in SOURCES:   

5. Interac,Visa,Cash,MasterCard. 

6. Click OK 

7. Watch the drop-down menu in the cell 
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1. Select data (In this example: Cities) 

2. Name your list (In this example: CITY) 

3. In "Date Validation" and then "Sources", type "=" and then the name you gave to the list   

  

 

1. Select cells to insert validation 

2. In "Sources," click on the reference and select the data 

 

In a particular cell, you can specify a minimum or maximum limit 

 

 

You can limit the authorized text in a cell to 10 characters or less. 
Similarly, you can set the specific length of the number or text so 
that it corresponds to the length, example: Maximum of 4 
characters. 

 

= City Method 2 
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What users see when they enter invalid data into 
a cell depends on how you set up data validation. 
You can choose to display an input message 
when the user selects the cell. Input messages 
are generally used to offer users advice on the 
type of data that can be entered into the cell. You 
can move this message if you wish. It then 
remains displayed until you move to another cell 
or press Esc. 

 
 

 

    

 

Icon Type Use to 

 

Stop 
Prevent users from entering invalid data into a cell. A Stop Alert offers two 
options: Retry or Cancel. 

 

Warning 

Warns users that the data entered is not valid, without preventing them from 
entering it. When a Warning message appears, users can click Yes to accept 
the invalid entry, no to change the invalid entry, or Cancel to delete the invalid 
entry. 

 

Information 

Informs users that the data entered is not valid, without preventing them from 
entering it. This type of error message is the most flexible. When an 
Information message appears, users can click OK to accept the value or 
Cancel to opt out. 
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 LIST OF SYMBOLS, CUSTOM FORMAT 

Order Format / cell / numbers / custom category  

Symbol Meaning 

0 
Always displays a number. If there is no number at this location, display a 0. For 

example, code 0.00 always shows two decimal places. 

# Shows a number only if there is one. Doesn’t show anything if there isn't one. 

? Like code 0 but displays a space instead of non-significant zeros. 

, 
The comma serves as a decimal separator. Can be defined as a point in the 

Windows configuration panel. 

% 
Converts the number into a percentage by multiplying by 100 and adding the 

sign. 

$ Shows the currency symbol. 

( ) Shows parentheses. 

Space 
The space is used to separate the thousands. Can be modified for a comma in 

the Windows configuration panel. 

_ 
The underscore leaves a space of 1 character. Can be used to align numbers 

both in the column and on the decimal symbol. 

d/m/yy 

dd-mmm-yyyy 

Date format posted for January 5, 1985 - 5/1/85 

Date format posted for January 5, 1985 - 05-Jan-1985 

dd/mm/yy Date format: posts 01/01/00 for January or 12/12/00 for December. 

mmm Shows the abbreviated names of the month (Jan to Dec). 

mmmm Shows the full name of the month (January to December). 

yy 

yyyy 

Shows the double-digit year 

Shows the four-digit year 

H Shows hours without zero (1 to 23). 

HH Shows hours with zero (01 to 23). 

hh:mm Shows hours and minutes 

[] 
Shows hours above 24 or minutes and seconds above 60. For example, [h]:mm 

gives 72:00 if the cell contains the value 3. 

[color] 
Shows according to the specified color. The available colors are black, blue, 

cyan, green, magenta, red, white, or yellow. Example: [red]. 
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 Error value 

ERROR 
VALUE CAUSE AND SOLUTION 

#VALUE! Error due to invalid name  

This error occurs when the app does not recognize the text contained in a formula.  

 You used a cell name or cell range that does not exist.  

 A name has been misspelled.  

 Text was entered into a formula without being placed in quotation marks.  

 A function has been misspelled.  

#DIV/0 Zero Division Error 

 Entering a formula that makes an explicit 0 division: for example, = 5/0  

 Using a reference to an empty cell or a cell containing 0 as a divider. 

#NAME? Error due to invalid name  

This error occurs when the app does not recognize the text contained in a formula.  

 You used a cell name or cell range that does not exist.  

 A name has been misspelled.  

 Text was entered into a formula without being placed in quotation marks.  

 A function has been misspelled.  

#REF! Invalid cell reference error 

This error occurs when a cell's coordinates are not valid.  

 You removed or merged cells that other formulas referred to.  

 You used an invalid cell link.  

#NUM! Number error  

 This error occurs if a formula or function contains invalid numerical values.  

 A number is too large or too small to be represented in Excel. Values must range from 
-1*10307 and 1*10307 

 A function that runs by iteration fails to find a result.  

 You used an incorrect argument in a function that requires a numerical argument.  

#N/A Missing value error 

This error occurs when a value necessary for the formula to function properly is missing.  

 A mandatory argument in the formula is absent.  

 An inappropriate argument is used in a formula.  

 VLOOKUP, HLOOKUP or INDEX functions search an unsorted line or column.  

#NULL! Zero value error  

This error occurs when you specify an intersection of two areas that do not intersect. The 
intersection operator is a character of spacing between references.  

Example =SUM(A1 A10). The two points (:) are missing to separate the two cells.  
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 Exercise Pivot Table  

Open the workbook "Pivot Table  

1. Pivot Table: sheet: "Boutique"   

 What is the total sales per season, view the values in $ 

 Add the "Category" field in Column Labels  

 Expand columns and make sure you keep the column 
width when updating. 

2. Pivot table: sheet: "Patient"   

 How many patients per age group (Group of 20)? 

 Rename this sheet: "Age group." 

 Add a chart to your Pivot Table (Pie) 

 

3. What is the number of patients per month, per site? 

 Show "Women" only 

 Do you prefer to see "Site" in rows or columns labels? 

 Hide "Filed headers" and adjust all your columns 
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4. Pivot table: sheet: "Patient"   

 What is the number of appointments per SITE, by SPECIALITY with the names of the 
doctors? Here's your result, respect the titles and the graphic presentation 

 Do not forget to change your report layout in "Tabular Form" 

 Hide "Subtotal" from "Specialty" 

 

 


